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Using the “Grants Map for CFA” for 2021 
 
 

Use the “Grants Map for CFA,” an online, layered map, to answer location questions; pinpoint, draw, 

and label the location of current or proposed elements of your project; and save/upload a map of your 

project location to the Consolidated Funding Application (CFA) for the Environmental Protection Fund 

Grants Program for Parks, Preservation and Heritage (EPF) or the Recreational Trails Program (RTP). 
 

Use the map to identify location information for your project location: 
 

• County, 

• ZIP Code Tabulation Area (ZCTA) and Poverty data, 

• Quadrangle index, and 

• Regional Economic Development Council. 
 

  Use the map to determine: 
 

• Is your project located within a designated Heritage Area? 

• Is your project listed on the State or National Register of Historic Places? 

Use the map to save and upload documents to the CFA such as, but not limited to: 

• a 1:24,000 scale topographic or planimetric map for the project location including quadrangle 

index, 

• a site plan showing the proximity of your project to a State park (park polygons) or property 

listed on the State or National Register of Historic Places (National Register listings), or 

• an aerial photo view (imagery) of your proposed project location. 
 

The online, layered map is available at: https://parks.ny.gov/grants/consolidated-funding-app.aspx. 

 

The map is made up of several layers. Layered files allow users to turn data layers on and off.  It is 

recommended that you select only a few layers at a time to avoid a lengthy wait for data to load. 
 

Most icons on the map allow you to hover your mouse over them to view text describing that tool. 

Below is a flat image of the map with some additional text to introduce you to the available features. 
 

Questions concerning use of the map may be directed to the NYS Office of Parks, Recreation and Historic 

Preservation (OPRHP) Regional Grants Administrator for your county as listed at 

https://parks.ny.gov/grants/contact.aspx. 

https://parks.ny.gov/grants/consolidated-funding-app.aspx
https://parks.ny.gov/grants/contact.aspx
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Enter address 

Save (PDF) and Print Menu 

List of layers (turn on or off; includes poverty level)  

Map Legend            
Draw tools (add pins/points, lines, shapes, and text to show your project location) 

Basemap Gallery (use Streets or USA Topo) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Zoom in 

Zoom out 

Home (Default extent) 

My Location (allow the map to identify your current location; use only if you are physically at the project site) 
Map scale 

Latitude/Longitude coordinates (Activate the + sign in the left-hand corner, then click on your project location to lock the coordinates.) 

 
 

Answer Location Questions for your project location in the CFA using the Grants Map for CFA 
 

The instructions below apply to most layers of the map including: 
 

• County, 

• ZIP Code, 

• ZIP Code Tabulation Area (ZCTA) and Poverty data, 

• Quadrangle index, and 

• Regional Economic Development Council (see the Location tab within the CFA online application). 
 

1.   Enter the street address, city, and state for your project location into the search box in the upper 
left-hand corner of the page.  Click the magnifying glass to search or select the appropriate address if 
it appears in the search results drop-down box that generates results as you type. 

 

If your project location does not have a street address, select the zoom in   or zoom out  

tools (as needed) which will magnify or minimize portions of the map.  Then, click and drag the map 
to center your project location. 

 
2.   If your project location has a street address, view the marked location on the map.  If correct, click 

the Esc (escape) key or click in the search box to clear the search results box from your screen.  If it 
is incorrect, try zooming in or out to find your project location on the map. 

 
3.   To identify any of the features listed above (county, ZIP code, etc.), use the layers tool.  Click on the 

List of Layers tool .  Select the layer that you wish to view for your project location such as 
Poverty by ZCTA 2019 ACS (American Community Survey). The boundaries for the ZIP Code 
Tabulation Areas will then appear on the map.  If you do not see anything added, try zooming out to 
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see the boundaries.  The map legend tool  will show you which layer you are viewing based on 

the color of the boundaries or shading.  See table below. Close the List of Layers box by clicking the X 

in the upper right-hand corner of that box. 
 

Map Legend 
 

   
 

 

4.   Once the boundaries appear, click on the point marking your project location.  Note the ZIP Code 
Tabulation Area (ZCTA) and the Percent Below Poverty Level (%) for your project location and 
enter that information into the answer for the appropriate question in the CFA.  For the 
Environmental Protection Fund (EPF) Grants Program for Parks, Preservation and Heritage, 
successful applicants are reimbursed for up to 50 percent of their eligible expenditures.  For 
projects located in impoverished areas (as defined by 10 percent or more of the population below 
poverty level according to the most recent Census data), the reimbursement can be up to 75 
percent of the eligible project cost. Note: Poverty Level by ZCTA data does not apply to the 
Recreational Trails Program (RTP). 
 

 
 

5.   If you selected more than one layer in the List of Layers tool, your results box will have an arrow in 
the upper right-hand corner.  Click the arrow to view the results of the next feature.  

        
6.   To view other features, go back to the List of Layers tool.  Uncheck the box for the layer(s) you 

already viewed.  Select another layer that you wish to identify for your project location. The  
       boundaries of that feature will then be added to the map.  Once the boundaries appear, click on the 

point marking your project location to view the data associated with that layer. 
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Is your project located within a designated NYS Heritage Area? 
 

 
The map includes layers for designated urban and regional NYS Heritage Areas with approved 

management plans.  Projects within the boundaries of the NYS Heritage Areas, along with other criteria 

outlined in the CFA Guidance Document, may be eligible for funding under the Heritage Areas program 

of the Environmental Protection Fund Grant Program for Parks, Preservation and Heritage (EPF).  For the 

Recreational Trails Program (RTP), rating points may be assigned to projects identifiable as a 

component of a Heritage Area.   
 

1.   Enter the street address, city, and state for your project location into the search box in the upper 
left-hand corner of the page.  Click the magnifying glass to search or select the appropriate address 
if it appears in the search results drop-down box that generates results as you type. 

 

If your project location does not have a street address, select the zoom in   or zoom out  

tools (as needed) which will magnify or minimize portions of the map.  Then, click and drag the map 
to center your project location. 

 
2.   If your project location has a street address, view the marked location on the map.  If correct, click 

the Esc (escape) key or click in the search box to clear the search results box from your screen.  If it 
is incorrect, try zooming in or out to find your project location on the map. 

 
3.   To determine if your project location is in a designated Heritage Area, use the layers tool. Click on the 

List of Layers tool .  Select both NYS Urban Heritage Areas and NYS Heritage Areas.  The 
boundaries will then appear on the map.  If you do not see anything added, try zooming in or out to 
see the boundaries.  Note that some Heritage Areas overlap, so you may wish to view only one type at 

a time. The Map Legend tool  will show you which type of Heritage Area boundary you are 

viewing. The NYS Urban Heritage Area boundaries are aqua; the NYS Heritage Area boundaries are 
blue.  Close the List of Layers box by clicking the X in the upper right-hand corner of that box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once the boundaries appear, click on the point marking your project location.  A results box will appear 
showing the name of the Heritage Area if your project is located within the boundaries. 
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Example of Urban Heritage Area: Albany 

 
 

Example of Heritage Area: Susquehanna 

 
 

To learn more about the Heritage Areas, visit https://parks.ny.gov/grants/heritage-
areas/default.aspx.  
 
Written approval/endorsement of the project by the local heritage area management entity, if it is 
not the project sponsor, is required with an application for funding under the Heritage Areas 
program of the Environmental Protection Fund Grant Program for Parks, Preservation and 
Heritage (EPF).  The letter should reference the appropriate Heritage Area management plan and 
relevant Heritage Area resources and goals.  If your project location is within a Heritage Area, to 
obtain the required endorsement, visit https://parks.ny.gov/grants/heritage-areas/default.aspx.  
Click on the Contact link to obtain a phone number and/or email address for the management 
entity for the Heritage Area in which your project is located. Note: An endorsement from the 
management entity for the Heritage Area is not required for applicants applying to the 
Recreational Trails Program (RTP).   
  

 

Is your project listed on the State or National Register of Historic Places? 
 

1.   Enter the street address, city, and state for your project location into the search box in the upper 
left-hand corner of the page.  Click the magnifying glass to search or select the appropriate address 
if it appears in the search results drop-down box that generates results as you type. 

 

If your project location does not have a street address, select the zoom in   or zoom out  

tools (as needed) which will magnify or minimize portions of the map.  Then, click and drag the map 
to center your project location. 

 

https://parks.ny.gov/grants/heritage-areas/default.aspx
https://parks.ny.gov/grants/heritage-areas/default.aspx
https://parks.ny.gov/grants/heritage-areas/default.aspx
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2.   If your project location has a street address, view the marked location on the map.  If correct, click 
the Esc (escape) key or click in the search box to clear the search results box from your screen.  If it 
is incorrect, try zooming in or out to find your project location on the map. 

 
3.   To determine if your project location is listed on the State or National Register of Historic Places, use 

the layers tool.  Click on the List of Layers tool .  Select NYS National Register Listings.  The 
boundaries will then appear on the map.  If you do not see anything added, try zooming in or out to 
see the boundaries.  The NYS National Register Listings are shown on the map in yellow. 

 

 
 

There are individually listed resources as well as historic districts; some of which overlap.  Under the 
Environmental Protection Fund Grants Program for Parks, Preservation and Heritage (EPF), a 
property shall be eligible for grant assistance if, prior to the award of the grant, it is: (a) individually 
listed on the State or National Register of Historic Places; or (b) located within a historic district 
which is listed on the State or National Register of Historic Places and which is identified in the 
district nomination form as contributing to the significance of the district. 
 

4.   If your project is located within the boundaries of a State or National Register listed place, click 
within the yellow boundary to bring up the results box.  The box will show the name of the listed 
resource (note: it may or may not be the official listed name) along with the National Register Listing 
Number.  If your project is individually listed, be sure you are viewing the resource name and listing 
number for the individual resource, not the entire historic district. Enter that name and number to 
answer the appropriate question in the CFA.  Questions about listings on the State or National 
Register should be directed to the OPRHP National Register Unit at (518) 268-2213.  

 
Example of National Register Listing 
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5.   Once you determine the National Register Listing Number, you can then use that number to 

find nomination data, including level of significance, in the Cultural Resource Information 
System (CRIS) at   the following web site: https://cris.parks.ny.gov.  At the CRIS Legal Disclaimer, 
click “I Agree” to proceed.  On the next screen, click “Proceed as Guest.”  Select the Search 
button, then enter the criteria to search the database.  Use the CRIS On-line Help System for 
search tips at https://cris.parks.ny.gov/CRISHELP/.  For questions or technical support 
regarding CRIS, please email: CRISHelp@parks.ny.gov.  

 

 

Save/upload a 1:24,000 scale topographic map for the project location including quadrangle index 
 

1.   From the Basemap Gallery , select USA Topo Maps.  It may take a little time for the map to 
transition to a different base map.  Zoom in or out to view the change to topo map as your base 
map. 

 
2.   Enter the street address, city, and state for your project location into the search box in the upper 

left-hand corner of the page.  Click the magnifying glass to search or select the appropriate address 
if it appears in the search results drop-down box that generates results as you type. 

 

If your project location does not have a street address, select the zoom in   or zoom out  

tools (as needed) which will magnify or minimize portions of the map.  Then, click and drag the map 
to center your project location. 
 

3.   If your project location has a street address, view the marked location on the map.  If correct, click 
the Esc (escape) key or click in the search box to clear the search results box from your screen.  If it is 
incorrect, try zooming in or out to find your project location on the map. 

4.   Mark your project location on the map using the Draw tools . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
For example, click on the point tool .  An additional menu of graphics will open showing 
various options to mark your project location. 

 

 

 

 

 

https://cris.parks.ny.gov/
https://cris.parks.ny.gov/CRISHELP/
mailto:CRISHelp@parks.ny.gov
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Graphics and options available when using Point tool 

 
 

Select the graphic that you want; you can change the color, size, transparency, and width as shown 
above.  Then, click on your project location on the map. 

 
Your project location is now marked. See the purple circle shown below. 

 

 
 

Please note that the clear button  will delete everything you added to your map, 

including your project location.  Use the Undo button if you want to go back and revise 
what you have drawn/marked. 

 
5.   If your project encompasses more than a particular point, such as the development of a hiking trail, 

you may show the project location with the various line and shape tools.  For example, show a 
current trail with a solid line; show the proposed connection trail with a dotted line.  To do so, click 

on the Draw tool .  Use the line ,  polyline , or freehand polyline  tool. 
Next select the type of line (dash, dotted, or a combination dash-dot) and color.  Click and hold to 
start drawing; let go to finish.  See the yellow, dotted line connecting to the purple circle below. 
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6.   You may also add text to your map.  Select the draw tool .  Click the text tool .  Type your 

text into the text box. View the Preview showing the color and size.  Adjust the color or size if desired.  

Then, click on the map where you want to place the text.  As you move your mouse across the map, if 

the text tool is activated, your cursor will show the text, “Click to add a point.” If the text tool is 

inactivated, click on it again .  The point you click will become the center point of your text. 

 
 

7.   Experiment with the Draw tools as desired to adequately show your project location.  When 

finished, close the Draw tool by clicking the X in the upper right-hand corner of that box. 
 
 

8.   Click on the List of Layers tool .  Select NYS Quadrangle Index.  Click on your project location 

to view the name of the quadrangle. 
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9.   Center your project location on the screen by clicking and dragging the map. 

10. Click on the Print tool  on the map itself. Do not use the Print menu in your Internet browser 

window. 

 

11. In the Print options, select Letter ANSI A Portrait from the Layout drop-down box and PDF in the 

Format field. 

 

. 

12. Enter the following information as shown below in the Map Title field and the Advanced menu: 

a.    Map Title (50 characters): Application #, Question #, Project Name 

b.   Author (100 characters): Quadrangle Index name 

c. Copyright (100 characters): Street address, city, state of the project location 
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d.   Force scale:  24000 (no comma)  
 
 
 
 

13. Click the Print button next to the Advanced button . 
 

 

14. A PDF of your map will be generated. 
 

 
 

If an error message appears instead of your PDF map, clear your browser’s cookies and history.  Note: 

you may lose any graphics or text you added to your map.  If you are using Internet Explorer, go to 
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Tools>Internet Options and in the “General” tab under “Browsing History,” click “delete.”  Check the first 

4 things in the list (“Preserve Favorites…,” Temporary Internet Files, Cookies, and History) and click 

“delete.” After this is done, click OK, exit out of your browser completely. Open Internet Explorer again 

and resume saving your map as PDF. 
 

15. Once the PDF has been generated, click on it to open it in PDF.  View it to ensure that all information 

needed is visible and legible.  Click File>Save as.  Give the map a filename including your CFA 

application #, the question # where the map will be uploaded, and the project name.  Save the map 

to your electronic files (such as your Desktop, downloads, or wherever you can find it again later). 
 

 

16. Upload the map to the CFA to the application question requesting a 1:24,000 scale map for the 

Environmental Protection Fund Grants Program for Parks, Preservation and Heritage (EPF) or the 
Recreational Trails Program (RTP). 

 

 
 

Questions concerning use of the map may be directed to the NYS Office of Parks, Recreation and Historic 
Preservation (OPRHP) Regional Grants Administrator for your county as listed at 
https://parks.ny.gov/grants/contact.aspx.  

https://parks.ny.gov/grants/contact.aspx

